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Version & Protection Information 

 
Welcome to the Manual for the Profile Library Editor. 
 
This document illustrates the usage of the Profile Library Editor which is used to modify the Profile 
Library of steel cross-sections within Scia Engineer. 
 

Version info 

Document Title Manual – Profile Library Editor 
Release 2013.1 
Revision  06/2013 

 

Protection info 

In order to use the Profile Library Editor, the Productivity Toolbox module (ESA.06) needs to be 
activated in the License. 
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Introduction 

This document illustrates the usage of the Profile Library Editor which is used to modify the Profile 
Library of steel cross-sections within Scia Engineer. 
 
In the first chapter the folder structure of the Profile Library as well as the naming and ordering of 
different libraries is explained. 
 
The second chapter discusses the Profile Library Editor which allows to add new sections to the library 
or edit and remove existing ones. Both main functions (editing and adding) are illustrated using a 
practical example. 
 
At the end of this document, several annexes are provided which give additional information. 
Annex A gives an overview of the Formcodes used within Scia Engineer, including all parameters 
which describe the shapes. 
 
Annex B provides a list of all Cross-section characteristics which can be inputted in the Profile Library. 
 
Annex C contains information regarding filters, which allow an easy filtering of the Profile Library 
section Types. 
 
The final annex, Annex D lists the different files located in the folder of the Scia Engineer Profile 
Library.  
 
 

 Within Chapter 2 an example MS Excel file is used named Example_Profile_Library.xlsx. This file is 
supplied with this manual 
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1. Profile Library Folders 

In this chapter the folder structure of the Profile Library as well as the naming and ordering of different 
libraries is explained. 

Default folders 
The first part of this chapter will focus on the structure of the Profile Library. Therefore, the directory 
settings of Scia Engineer are examined: 
 
- Launch Scia Engineer. 
 

- When the Open project dialog appears, press . 
 
- Go to Setup > Options 
 
- Go to the tab Directories 
 
- Set the 'Show directories for:' combo-box to Profile Libraries 
 

 

 The actual numbers in the folders (ESA13.0, ESA13.1, ...) can differ depending on the version of 
Scia Engineer which is installed. 
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By default two directories are listed in this dialog, one referring to the installation folder and one 
referring to the user folder. In general they can be written as follows: 
 
Folder	1:	"C:\Program	Files	(x86)\Scia\EngineerXXXX.X\ProfileLibrary\"	
 
The first directory refers to the installation folder of Scia Engineer. The ProfileLibrary subfolder contains 
the so-called System library i.e. the Profile Library which is supplied with Scia Engineer. 
 
 
Folder	2:	"C:\Users\#USER#\ESAXX.X\User\ProfileLibrary\UserLibrary\"	
 
The second folder refers to the user folder of Scia Engineer. This specific path refers to the UserLibrary 
i.e. the default location where any new Library sections added by the user will be stored. 
 

Using the New  and Delete  buttons folders can be added or removed. In this way it is for 
example possible to set a Profile Library folder located on a network location. 
 

 When installing a patch of Scia Engineer, the ProfileLibrary will be updated. The UserLibrary will 
not be modified, so no data is lost/overwritten when applying a patch. It is therefore recommended 
to always use the UserLibrary when adding new sections! 

 
 

Library naming and order 
Each folder entry is seen as a separate library. Each library receives a name equal to the last subfolder 
of the path. The number (or order) of these libraries depends on the order in which they are listed in the 
dialog. 
 
For the two default folders specified above this means that the first folder will be labeled ProfileLibrary 
and seen as the first library while the second folder is labeled as UserLibrary and is seen as the 
second library. 
 
If for example a third folder would have been added labeled "D:\Test\Scia" then this folder would 
represent the 3rd library (by its order in the list) and would be labeled Scia (the name taken from the 
last subfolder of the path). 
 

Using the Move Item Up/Down  buttons the order of folders (Libraries) can be changed but 
this is not required.  
 

 Scia Engineer always takes the first folder as being the System library. 

 

Folder Content 
A rundown of the content of the ProfileLibrary folder can be found in Annex D. 
 
The UserLibrary folder will be empty initially. Files are generated in the UserLibrary folder when 
sections are added into this library. This is illustrated in Chapter 2. 
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2. Profile Library Editor 

In this chapter the Profile Library Editor is discussed which allows the user to add new sections to the 
library or edit and remove existing ones. 
 

Edit Profile Library 
In order to open the Profile Library Editor a new project needs to be created (or an existing one 
opened). 
 
- Launch Scia Engineer. 
 

- When the Open project dialog appears, press . 
 
- Go to File > New 
 

- Select a new Analysis project  
 

- Confirm the selection with .  
 
The Project data dialog opens: 
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- In this dialog, set the National Code to for example EC-EN, activate Steel material and set the 
Project Level to Advanced.  

 A different National Code may also be selected but it should contain Steel material. 

 

- Confirm these settings with .  
 
When the project environment is loaded the Profile Library Editor can be opened either through the 
Menu toolbar at the top or through the tree in the Main dialog. 
 

         
 
- Go to Tools > Edit profile library 
 
 
The Edit Profile Library dialog appears: 
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Using the  button a New section type can be added to a library (either system or user). 
 
The Existing type combo-box shows an alphabetical list of all sections found in the different Libraries. 
This list shows the content of all Libraries set in the Profile Library Folders (see Chapter 1). 
 

When an Existing type is selected this can either be edited using the button or removed 

using the button. 
 
In the following paragraphs the different options of this dialog are further elaborated. 
 

Editing an existing section type 
In this paragraph, the editing of an existing section type is illustrated by means of an example. 
 
- Follow the steps of the previous paragraph to get to the Edit Profile Library dialog. 
 
- In the Existing type combo-box either select IPE from the drop-down list or type IPE into the input 
field. 
 

 
 

- Now press the button. 
 
 
The Profile Library Editor will open, showing the data for the selected type (IPE). 
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On the previous picture the different items of the dialog have been marked by red numbers (X). These 
items will now be discussed one by one in the following paragraphs. 
 

1. Type 

The Type, marked with number (1) on the Profile Library Editor picture shows the type of the selected 
section, in this case "IPE". 
 
The Type may only contain letters i.e. no numbers.  
 
Additional information regarding the Name of a section is given in Paragraph 8. 
 
 

2. Library 

The Library, marked with number (2) on the Profile Library Editor picture shows the Library in which 
this Type is located. 
As specified in Chapter 1 the naming and ordering of the libraries depends on the folder name and 
order in the directory settings. 
 
In this example, the IPE type is located in the ProfileLibrary which is the 1st library (denoted by the 1). 
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3. & 4. Formcode and picture 

Within Scia Engineer, each shape within the Profile Library is uniquely identified by a so called 
Formcode. The Formcode defines the shape, the parameters which describe the shape and in some 
cases also additional parameters like distance between bolt holes, unit warping ordinates etc. 
 
Annex A of this manual gives a complete overview of all Formcodes used within the Profile Library 
including pictures of the shapes and descriptions of the different parameters. 
 
Within the Profile Library Editor picture the Formcode is marked with number (3). Number (4) shows 
the corresponding picture which details the shape of this Formcode and all parameters which define 
this shape. 
 
In this example, the IPE Type has Formcode 1 i.e. I-sections. The picture shows the I-section shape 
including an overview of all geometrical parameters which define this shape. 
 
 

5. Fabrication 

The Fabrication, marked with number (5) on the Profile Library Editor picture provides the default 
fabrication for this Type. 
When any section of this Type is inputted in the Scia Engineer Cross-Section Manager it will get this 
fabrication by default. 
 
The drop-down list allows a selection between Rolled, Welded and Cold-formed which represent the 
main fabrications for steel library sections. 
 
In this example, the IPE Type concerns hot-rolled I-sections and thus the Fabrication is shown as 
Rolled. 
 
 

6. Description 

The Description combo-box is marked with number (6) on the Profile Library Editor picture. 
 
The Description field shows a description of the Type as given by the manufacturer. For example 
"European standard beam", "Cold formed C section", "British parallel flange channel"... 
 
 
The content of the Description drop-down list is defined in the file Descrip_ID.txt located in the folder 
of the selected Library. This file can be edited using a default text editor. 
 

 
 
On each line within this file, two fields are defined which are separated by a semicolon. 
 
The first field gives a number while the second field concerns the actual Description string. 
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Within the Profile Library Editor the respective item can then be selected from the drop-down list. 
 

 
 

 The number is only shown in this dialog, in order to make it convenient for the user to select the 
proper string. Within Scia Engineer, for example in the Cross-Section Manager, only the 
Description string is shown, not the number. 

 
In this example the IPE Type is set as "1 European I beam". 

 Each library (folder) has its own Descrip_ID.TXT file. When editing a type, make sure to edit the 
corresponding Descrip_ID.TXT file of that library since else the changes will not be visible.  

 

Extension: Translations 

The content of the Descrip_ID.txt file is used by default for any interface language of Scia Engineer. 
 
Within the standard ProfileLibrary folder, additional Descrip_ID files can be found i.e. Descrip_ID_05, 
Descrip_ID_07, Descrip_ID_0c... 
 
These files have the same content as the standard Descrip_ID.txt file but contain strings for specific 
languages. The number used to identify a certain language concerns the Locale ID (LCID) as provided 
by Microsoft. More specifically the last two digits of the LCID are used. The following table illustrates 
this principle: 
 

Language LCID Number used in filename 

Czech 

 

0405 05 

German 

 

0407 07 

English 

 

0809 09 

French 

 

040c 0c 

Dutch 

 

0813 13 

Slovak 041b 1b 
 
A list of all LCID's as provided by Microsoft can be found on the MSDN website. 
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Thus when the interface of Scia Engineer is for example set to German, the Description strings will be 
read from the file Descrip_ID_07.txt. In case this file does not exist, the content of Descrip_ID.txt is 
used. 
 

 These Translations are only used by the standard ProfileLibrary, not the UserLibraries. 

 

7. Source 

The Source combo-box is marked with number (7) on the Profile Library Editor picture. 
 
The Source field gives a reference to the source documentation from which the data of this Type was 
gathered. Typically it refers to the catalogue of a manufacturer or a book in which the data was 
published. 
 
The content of the Source drop-down list is defined in the file Source_ID.txt located in the folder of the 
selected Library. This file can be edited using a default text editor. 
 

 
 
On each line within this file, three fields are defined which are separated by a semicolon. 
 
The first field gives a number while the second field concerns the actual Source string. The third field is 
currently not used thus remains empty. 
 
Within the Profile Library Editor the respective item can then be selected from the drop-down list. 
 

 
 

 The number is only shown in this dialog, in order to make it convenient for the user to select the 
proper string. Within Scia Engineer, for example in the Cross-Section Manager, only the Source 
string is shown, not the number. 

 
In this example the IPE Type is set as "20 ArcelorMittal / Sales Programme / Version 2012-1". 

 Each library (folder) has its own Source_ID.TXT file. When editing a type, make sure to edit the 
corresponding Source_ID.TXT file of that library since else the changes will not be visible.  
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Extension: Translations 

The content of the Source_ID.txt file is used by default for any interface language of Scia Engineer. 
 
Within the standard ProfileLibrary folder, additional Source_ID files can be found i.e. Source _ID_05, 
Source _ID_07, Source _ID_0c,... 
 
These files follow the same logic as explained for the Description strings. 
 
 

8. Name, Parameters & Properties 

The grid marked with number (8) on the Profile Library Editor picture concerns the core of the Editor. 
 
On each line of this grid the following data for one section of the given Type can be set: 
 

- Name: The first column in the grid contains the section Name. 
 

A section Name is defined by a 'Type' and a 'Code'. For example an IPE200 has Type "IPE" 
and Code "200". The first number in the Name defines the start of the 'Code'. 
 
The following conditions apply for the naming: 
- The Type may only contain letters i.e. no numbers 
- The Code has to start by a number and may also contain letters 
 
So an IPE180A is fully valid and has Type "IPE" and Code "180A". 
 
The Name always starts with the Type, so in this specific example, all sections start with 
"IPE" in their name. 

 The Type can also contain a part between brackets. This can be used to differentiate between 
sections which have the same Type, for example L(ARC), L(ARCI), L(CSN). Within the Cross-
Section manager, when a cross-section is added to the project,  the part between the brackets is 
automatically omitted from the Type, so all three L-Types given above will be listed as L once 
inputted. 

 
- Parameters: Next to the Name different columns are shown for the Parameters which describe the 
shape for the selected Formcode. 
 

As specified in Paragraph 3. & 4. the Parameters depend on the Formcode and are shown 
on the picture of the shape. 
 
The Parameters can be easily recognized due to their blue font. 
 
All standard Parameters which are required for the shape definition need to have values 
different from zero. In addition, when the dialog is closed additional tests are done to verify if 
the inputted data is sensible (An I-section cannot have a web thickness which is larger than 
its height etc). 
 
Parameters which are not required for the shape can remain zero in case they are not used. 
Examples include the flange slope in case of a section with parallel flanges, the internal bolt 
distance etc. 
 
In the example, when the first section in the grid is examined the following can be seen: 
 

 
 
These Parameters define the shape of the IPE80 I-section. The remaining parameters r1, a, 
W and wm1 are not used in this case and remain zero. 
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The units used for these Parameters concern the standard Scia Engineer Cross-Section 
units. These units can be modified in Setup > Units > Cross-section > Length. 

 
 
 
 

- Properties: The remainder of the grid concern columns which contain the different Properties. 
 

A list of all Properties which can be set in the grid can be found in Annex B. 
 
In essence it is not required to input any Property. Each Property value which remains zero 
will later on, when the cross-section is used, be calculated automatically by Scia Engineer. It 
is thus possible to define only Parameters and no Properties. 
 
In the example, when the first section in the grid is examined the following can be seen: 
 

 
 
For the IPE80 this shows that A, AL, IYLCS and IZLCS have been inputted according to the 
documentation given in the Source field while the Ay, Az and AD properties are not defined 
and will thus be calculated automatically by Scia Engineer. 
 
The units used for these Properties concern the standard Scia Engineer Cross-Section units. 
These units can be modified in Setup > Units > Cross-section > Properties. 
 
 

 
The grid fully supports the Copy and Paste functionality from MS Excel. It is thus possible to Paste 
data obtained from MS Excel, or first Copy data from the Editor to MS Excel, modify the data and 
Paste it back into the Editor etc. This functionality will be further illustrated in the subsequent 
Paragraph for adding a new section Type. 

 
 

9. Always use library values 

Number (9) on the Profile Library Editor picture concerns a specific checkbox labeled Always use 
library values. 
 
For the functionality of this checkbox reference is also made to [1] regarding the calculation of Cross-
section properties. 
 
Within Scia Engineer, by default, all cross-section properties are calculated. After the properties have 
been calculated, the values are compared with the values defined in the Profile Library. In case the 
difference between the calculated and the inputted value is less than 10% the inputted value from the 
Library is used. 
 
This so-called 10% rule is intended specifically to avoid errors in the input of the Library values. In 
typical cases, the values within the Library (provided by manufacturer tables) are rounded off values 
and fall within this 10% range. 
 
In the actual example, the Library contains a value for the area A of an IPE80 of 764 mm² coming from 
the manufacturer's table. The calculated area A for an IPE80 is 764,74 mm². Since the values differ 
less than 10%, within the Cross-Section Manager the Library value of 764 mm² is used. 
 
For very special applications it is possible to activate the checkbox Always use library values. As this 
checkbox indicates, in this case the library values will ALWAYS be used, even if they differ more than 
10%.  
A typical example could be a Pair section (Formcode 127 or 128) in which the manufacturer indicates 
to use the inertia Iz around the weak axis as the sum of the inertias of the different parts. 
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In this case the Iz value in the Library will be much lower than the calculated one, thus by using the 
Always use library values checkbox it can be forced to always use the inputted values. 
 

 Any values which are inputted as zero will still be calculated by Scia Engineer, independent if the 
Always use library values checkbox is activated or not. 

 

 The Always use library values checkbox should be used with care since the safety rule of 10% is in 
fact skipped.  The user should double check the inputted values to make sure there are no errors in 
the input. 

 
 

10. Note, Save & Cancel 

 
The final items, noted by number (10) on the Profile Library Editor picture are located at the bottom. 
 

- Save: The  button is used to store changes made to the library after which a 
confirmation dialog will be shown.  

 
In case the Always use library values checkbox was activated an additional 
warning will be given to make sure the user activated this checkbox intentionally. 
 
In case there is an error in any of the input fields a message will be given to explain 
what the error is (for example h > b) and the cell which contains the incorrect value 
will be highlighted. 
 

- Cancel: Using the  button the dialog can be closed without storing any 
changes. 
 
- Note: The note shown at the bottom of the dialog is quite important:  
 

 
 
When Scia Engineer is open, data from the Library is already loaded in memory. In order to 
reflect the changes Scia Engineer should be closed and re-opened. 
 

 Closing and re-opening Scia Engineer applies specifically in case new sections are added into the 
Library. When data of an existing section has been edited it is not imperative to close and re-open 
Scia Engineer. 

 
 

- To finalize this example press the  button in order to avoid making any changes to the 
standard IPE Type. 
 

- The Edit Profile Library dialog can then also be closed by pressing . 
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Adding a new section type 
The previous paragraph illustrated how an existing Type can be edited and explained the different 
parts of the Profile Library Editor. 
 
In this paragraph, the adding of a new section Type is illustrated by means of an example. 
 

Example Section Type 

The following table shows typical manufacturer data for a hot-rolled section Type "UI": 
 

 
 
The data was obtained from a fictive reference "Treatise on UI-sections / 1st Edition / 2013" and 
describes the parameters and properties of a "Universal I-section". 
 

 In order to follow this example, either use the MS Excel file Example_Profile_Library.xlsx provided 
with this manual or create a new MS Excel sheet with the same data. 

 
 

Step 1: Create a new project / Open an existing project 

In order to add new sections into the profile Library, first of all a project is needed. Either an existing 
project can be opened or a new project can be created. 
 
For this example a new project will be created. 
 
 
- Launch Scia Engineer. 
 

- When the Open project dialog appears, press . 
 
- Go to File > New 
 

- Select a new Analysis project  
 

- Confirm the selection with .  
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The Project data dialog opens: 
 

 
 
 
- In this dialog, set the National Code to for example EC-EN, activate Steel material and set the 
Project Level to Advanced.  

 A different National Code may also be selected but it should contain Steel material. 

 

- Confirm these settings with . 
 
 
The project will now be created with the selected settings. 
 
 

Step 2: Set correct units 

Data provided by a manufacturer will have manufacturer specific units. For example some 
manufacturers show all units in [mm], others use [cm], others use Imperial units etc. 
 
In order to have a smooth copy/paste operation later on, the units within Scia Engineer are modified to 
match those used in the MS Excel sheet. 
 
In this specific case, both the Parameters and Properties are given in [mm]. The units within Scia 
Engineer can be changed as follows: 
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- Go to Setup > Units 
 
 
- Open up the tree nodes for Cross-section Length and Cross-section Properties 
 

 
 
In this dialog it can be seen that the unit for Cross-section Length is already set to [mm]. The unit for 
Cross-section Properties however is by default set to [m]. 
 
 
- Change the Unit combo-box from Cross-section Properties to [mm]. 
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- Confirm the changes with . 
 
The units within Scia Engineer now match with the units used in the MS Excel sheet. This will make the 
Copy/Paste from the data much easier. 
 

 In some cases it can be required to modify the data in the MS Excel file in order to have equal units 
between MS Excel and Scia Engineer. 
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Step 3: Open the Profile Library Editor 

The Profile Library Editor can now be opened either through the Menu toolbar at the top or through the 
tree in the Main dialog. 
 

         
 
- Go to Tools > Edit profile library 
 
The Edit Profile Library dialog appears: 
 
 

  
 

- Use the  button to indicate that a New section type will be defined. 
 
The New Type dialog appears in which the basic information for the new type can now be defined. 
 



Manual – Profile Library Editor 

20 

 
 
- Within the Type input field the string for the Type can be defined, in this case UI. 
 

 
 
The Formcode combo-box can now be used to set the proper Formcode. As detailed in Chapter 2 and 
Annex A, the Formcode defines the shape and all related shape parameters. 
 
- Since the new UI Type concerns an I-section shape the Formcode is left on the default 1 I sections. 
 
The Library combo-box is used to specify in which Library the new section type will be created. By 
default, this combo-box will always point to the UserLibrary (the second entry in the Folder settings as 
explained in Chapter 1).  
 
When installing a patch of Scia Engineer, the UserLibrary will not be modified, so no data is 
lost/overwritten when applying a patch. It is therefore at all times recommended to use the UserLibrary 
when adding new section types. 
 
- Following the above logic, the Library is left on the default 2 UserLibrary. 
 

- Confirm the changes with . 
 
 
The Profile Library Editor will now open. 
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Step 4: Copy data from MS Excel 

 
The Profile Library Editor shows an empty grid at this point. All the information from the previous dialog 
is visible here and the Formcode is illustrated by a picture and parameter description. 
 

 
 
 
- The Fabrication combo-box is by default set to Rolled. Since the UI Type concerns hot-rolled I-
sections this setting is left on the default. 
 
- The Description and Source combo-boxes at this time are empty since this is the very first entry 
ever made in this UserLibrary. Therefore, the Source_ID.txt and Descrip_ID.txt files as specified in 
Chapter 2 are not yet generated. In a subsequent step they will be defined. 
 
 

Name and Parameters 

The first data which will be copied from the MS Excel sheet will be the name and parameters. Before 
starting it is always advised to check if the data in Excel is shown in the same order as in the Editor. 
The columns in the MS Excel sheet should be repositioned accordingly. 
In this example, the order of the property columns matches. 
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- Within the MS Excel sheet, select the name and parameter values (h, b, tf, tw, r) as shown on the 
following screenshot: 
 

 
 
 
- Within the MS Excel sheet, right-click the selection and select Copy from the context menu. 
 

 
 
 
- Within Scia Engineer, put the mouse cursor just before the first line of the grid, right-click and select 
Paste from the context menu. 
 
 

 
 
The data has been copied into the grid. The parameters receive the blue color code. 
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Properties 

In the same way the properties can now be copied. The MS Excel sheet provides data for four different 
properties which are located on different places in the grid. Therefore these properties will be copied 
separately. 
 
- Within the MS Excel sheet, select the area A values as shown on the following screenshot: 
 
 

 
 
 
- Within the MS Excel sheet, right-click the selection and select Copy from the context menu. 
 

 
 
 
- Within Scia Engineer, put the mouse cursor on the first cell of the area A, right-click and select Paste 
from the context menu. 
 

 
 
The values of the area A are now copied into the grid. 
 

 
 

 When performing grid operations note that, both in MS Excel and in the Scia Engineer grid, the 
context menu which is shown on a right-click differs in case a cell is selected or in case the content 
of a cell is being edited. In the above example at all times the cell is being selected, not edited. 
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- Within the MS Excel sheet, select the inertia Iy and Iz values as shown on the following screenshot: 
 

 
 
 
 
- Within the MS Excel sheet, right-click the selection and select Copy from the context menu. 
 

 
 
 
 
- Within Scia Engineer, put the mouse cursor on the first cell of the inertia Iy, right-click and select 
Paste from the context menu. 
 

 
 
The values of the inertia Iy and Iz are now copied into the grid. 
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- Within the MS Excel sheet, select the torsional constant It values as shown on the following 
screenshot: 
 

 
 
 
 
- Within the MS Excel sheet, right-click the selection and select Copy from the context menu. 
 

 
 
 
- Within Scia Engineer, put the mouse cursor on the first cell of the torsional constant It, right-click and 
select Paste from the context menu. 
 

 
 
The values of the torsional constant It are now copied into the grid. 
 
 

 
 
All data from the MS Excel file has now been transferred into the Profile Library. 
 

 In this Step the copy/paste functionality from MS Excel to the Profile Editor grid was illustrated. In 
the same way, data can be copied from the grid and pasted into MS Excel. 
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Step 5: Save the data and close Scia Engineer 

The modifications can now be saved into the database. 
 

- Press the  button 
 
A confirmation is given that the data was successfully saved. 
 

 
 

- Confirm this message by pressing the  button. 
 
The Edit Profile Library dialog re-appears.  
 

 
 
This provides the possibility to add another section type etc. 
 

- For this example no more new type is added so the dialog is closed by pressing . 
 
As indicated in Chapter 2, the new changes made to the Profile Library will only be visible after Scia 
Engineer has been closed and re-opened. 
 
- To finalize this step, close Scia Engineer.  
 

 The project may be saved so it can be re-opened in a next step or the project may be closed 
without saving. The data has been saved in the Profile Library, not the project, so by discarding the 
project the data within the Profile Library is not lost. 

  



Manual – Profile Library Editor 

27 

Step 6: Source & Description 

When the data was saved in the previous step, Scia Engineer detected that there were no Source and 
Description files within the UserLibrary folder and created those files automatically. 
 
- Using Windows Explorer, navigate to the UserLibrary folder (see Chapter 1). 
 
- Open the Descrip_ID.txt file using any default text editor. 
 

 
 

Since the file is newly created it shows only one line, which has the not specified description. 
 
- For this example, a new line is added with the number 1 and description Universal I-section. As 
specified in Chapter 2 both fields (number and description string) are separated by a semicolon. 
 

 
 
- Save the changes made to the Descrip_ID.txt file. 
 
- Close the text editor. 
 
 
 
In the same way the Source will now be added. 
 
- Using Windows Explorer, navigate to the UserLibrary folder (see Chapter 1). 
 
- Open the Source_ID.txt file using any default text editor. 
 

 
 

Since the file is newly created it shows only one line, which has the not specified description. 
 
- For this example, a new line is added with the number 1 and source Treatise on UI-sections / 1st 
Edition / 2013. As specified in Chapter 2, the source definition consists of three fields which are 
separated by semicolons and of which only the first two are used. 
 

   
 
- Save the changes made to the Source_ID.txt file. 
 
- Close the text editor. 
 
Both files now contain the required data and thus this information can now be assigned to the Profile 
Library. 
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- Launch Scia Engineer. 
 
- When the Open project dialog appears, either re-open the project saved in Step 5 or, if the project 
was discarded, Cancel the dialog and create a new project as outlined in Step 1.  
 
- Go to Tools > Edit profile library 
 
The Edit Profile Library dialog appears: 
 
- In the Existing type combo-box either select UI from the drop-down list or type UI into the input field. 
 

 
 

- Now press the button. 
 
The Profile Library Editor will open, showing the data for the selected type (UI). 
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The drop-down list of the Description combo-box now shows the modified content of the 
Descrip_ID.txt file: 
 

 
 
- Change the Description combo-box to 1 Universal I-section. 
 
 
The drop-down list of the Source combo-box now shows the modified content of the Source_ID.txt 
file: 
 

 
 
- Change the Source combo-box to 1 Treatise on UI-sections / 1st Edition / 2013. 
 

 
 

- Press the  button to store the changes. 
 
A confirmation is given that the data was successfully saved. 
 

 
 

- Confirm this message by pressing the  button. 
 
The Edit Profile Library dialog re-appears.  
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- Close this dialog by pressing . 
 

 In case the Source_ID.txt and Descrip_ID.txt files already exist, they can directly be used in Step 4 
so Step 6 would not be required. 

 

Step 7: Review the Cross-section 

The new UI section Type is now defined into the Profile Library with its proper Source and Description 
strings. The cross-section can now be used in the Cross-section Manager. 
 
- Go to Libraries > Cross-sections 
 

 
 
The Cross-section Manager as well as the New cross-section dialog will open. In case in Step 6 an 

existing project was opened which already contained cross-sections then press the  button to 
open the New cross-section dialog. 
 
- In the Available groups select Profile Library. 
 

- In the Available items of this group select the  icon. 
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The new UI Type will now be visible. As can be seen, Scia Engineer automatically shows the cross-
sections of all the defined libraries: ProfileLibrary, UserLibrary and any others as set in the library 
folders (see Chapter 1). 
 
At the bottom the Source and Description strings will be visible: 
 

 
 
 

- Select Type UI and code 100 and press the button. 
 
The Cross-section dialog will open, showing the properties of the inputted cross-section. 
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The Source and Type descriptions subgroup will show the Source and Description. 
 
The Fabrication is set to rolled, as defined in the Profile Library Editor.  
 
The value of the Area A concerns the nicely rounded value which was inputted in the Profile Library 
Editor (the exact value for this shape would be 1032 mm^2) 
 
Scrolling to the bottom of the dialog shows the parameters of this section (h, b, tf, tw, r) and the 
Formcode. 
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This cross-section can now be used within the Scia Engineer model, checks... 
 

- Close the Cross-section dialog by pressing . 
 

- Close the New cross-section dialog by pressing . 
 

- Close the Cross-section manager by pressing . 
 
 
- Scia Engineer can now be closed, the project changes can be discarded. 
 
 
This concludes the example for defining a new Section Type in the Profile Library Editor. 
 

 Annex C illustrates the creation of a Profile Library filter with which the new section Type can be 
filtered. 
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Annex A: Profile Library Formcodes 

Within Scia Engineer, each shape within the Profile Library is uniquely identified by a so called 
Formcode. The Formcode defines the shape, the parameters which describe the shape and in some 
cases also additional parameters like distance between bolt holes, unit warping ordinates etc. 
 
In this Annex the different Formcodes and their parameters are described. 
 

Formcode 1: I-Section 

 
 
 

Parameters Description 

h Height 

b Flange width 

t Flange thickness 

s Web thickness 

r Radius at flange root 

r1 Radius at flange toe  

a Flange slope 

W Internal bolt distance 

wm Unit warping at flange toe 
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Formcode 2: Rectangular Hollow Section 

 
 

Parameters Description 

h Height 

b Width 

s Thickness 

r Outer radius 

r1 Inner radius 
 
 

Formcode 3: Circular Hollow Section 

 
 

Parameters Description 

d Diameter 

w Thickness 
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Formcode 4: L-Section 

 
 

Parameters Description 

h Height 

b Width 

t Thickness 

r Radius at flange root 

r1 Radius at flange toe 

W1 Bolt distance 

W2 Bolt distance 

W3 Bolt distance 
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Formcode 5: Channel Section 

 
 

Parameters Description 

h Height 

b Flange width 

t Flange thickness 

s Web thickness 

r Radius at flange root 

r1 Radius at flange toe 

a Flange slope 

wm1 Unit warping at flange root 

wm2 Unit warping at flange toe 
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Formcode 6: T-Section 

 
 

Parameters Description 

h Height 

b Flange width 

t Flange thickness 

s Web thickness 

r Radius at flange root 

r1 Radius at flange toe 

r2 Radius at web root 

a1 Flange slope 

a2 Web slope 
 
 

Formcode 7: Full Rectangular Section 

 
 

Parameters Description 

h Height 

b Width 
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Formcode 11: Full Circular Section 

 
 

Parameters Description 

d Diameter 
 
 

Formcode 101: Asymmetric I-Section 

 
 

Parameters Description 

h Height 

s Web thickness 

bt Flange width top 

bb Flange width bottom 

tt Flange thickness top 

tb Flange thickness bottom 

r Radius at flange root 
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Formcode 102: Rolled Z-Section 

 
 

Parameters Description 

h Height 

b Flange width 

t Flange thickness 

s Web thickness 

r Radius at flange root 

r1 Radius at flange toe 
 
 

Formcode 111: Cold-Formed Angle Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Width 

h Height 
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Formcode 112: Cold-Formed Channel Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 
 
 

Formcode 113: Cold-Formed Z-Section 

 
Parameters Description 

s Thickness 

r Inner radius 

b Total width 

h Height 
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Formcode 114: Cold-Formed C-Section 

 
 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

c Lip 
 
 

Formcode 115: Cold-Formed Omega Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Total width 

h Height 

c Inner length 
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Formcode 116: Cold-Formed C-Section Eaves Beam 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

c Lip 

a Flange angle 
 

Formcode 117: Cold-Formed C-Plus Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

c Lip 

c2 Pluslip 

a Pluslip angle 
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Formcode 118: Cold-Formed ZED-Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

bt Flange width top 

bb Flange width bottom 

h Height 

c Lip 
 

Formcode 119: Cold-Formed ZED-Section Asymmetric Lips 

 
 

Parameters Description 

s Thickness 

r Inner radius 

bt Flange width top 

bb Flange width bottom 

h Height 

ct Lip top 

cb Lip bottom 
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Formcode 120: Cold-Formed ZED-Section Inclined Lip 

 
 

Parameters Description 

s Thickness 

r Inner radius 

bt Flange width top 

bb Flange width bottom 

h Height 

ct Lip top 

cb Lip bottom 

a Lip angle 
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Formcode 121: Cold-Formed Sigma Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

b1 Web depression 
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Formcode 122: Cold-Formed Sigma Section Stiffened 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

c2 Pluslip 

b1 Web depression 
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Formcode 123: Cold-Formed Sigma-Plus Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

c2 Pluslip 

b1 Web depression 

a Pluslip angle 
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Formcode 124: Cold-Formed Sigma Section Eaves Beam 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

b1 Web depression 

a Flange angle 
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Formcode 125: Cold-Formed Sigma-Plus Section Eaves Beam 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

c2 Pluslip 

b1 Web depression 

a Flange angle 

a2 Pluslip angle 
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Formcode 126: Cold-Formed ZED-Section Both Lips Inclined 

 
 

Parameters Description 

s Thickness 

r Inner radius 

bt Flange width top 

bb Flange width bottom 

h Height 

ct Lip top 

cb Lip bottom 

a Lip angle 
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Formcode 127: Cold-Formed I-Plus Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

c Lip 

c2 Pluslip 

a Pluslip angle 
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Formcode 128: Cold-Formed IS-Plus Section 

 
 

Parameters Description 

s Thickness 

r Inner radius 

b Flange width 

h Height 

h1 Web height near flange 

h2 Inner web height 

c Lip 

c2 Pluslip 

b1 Web depression 

a Pluslip angle 
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Formcode 129: Cold-Formed Sigma Section Asymmetric 

 
 

Parameters Description 

s Thickness 

r Inner radius 

bt Flange width top 

bb Flange width bottom 

h Height 

h1 Web height near flange 

h2 Inner web height 

ct Lip top 

cb Lip bottom 

b1 Web depression 
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Formcode 150: Rail Type KA 

 
 

Parameters Description 

h1 Height 

h2 Intermediate top height 

h3 Intermediate top height 

b1 Width bottom 

b2 Intermediate width 

b3 Intermediate width 

k Width top 

f1 Intermediate bottom height 

f2 Intermediate bottom height 

f3 Intermediate bottom height 

r1 Radius 

r2 Radius 

r3 Radius 

r4 Radius 

r5 Radius 

a Wear 
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Formcode 151: Rail Type KF 

 
  

Parameters Description 

h1 Height 

h2 Intermediate top height 

h3 Intermediate top height 

b1 Width bottom 

b3 Intermediate width 

k Width top 

f1 Intermediate bottom height 

f3 Intermediate bottom height 

r1 Radius 

r2 Radius 

r3 Radius 
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Annex B: Cross-section Characteristics 

The following table provides an overview of all Cross-section Characteristics which can be inputted into 
the Profile Library:  
 

Property Description 

A Area 

Ay Shear Area in principal y-direction 

Az Shear Area in principal z-direction 

AL Circumference per unit length 

AD Drying Surface per unit length 

cYUCS Centroid coordinate in Y-direction of Input axis system 

cZUCS Centroid coordinate in Z-direction of Input axis system 

IYLCS Second moment of area about the YLCS axis 

IZLCS Second moment of area about the ZLCS axis 

IYZLCS Product moment of area in the LCS system 

α Rotation Angle of the principal axis system 

Iy  Second moment of area about the principal y-axis 

Iz  Second moment of area about the principal z-axis 

iy  Radius of gyration about the principal y-axis 

iz  Radius of gyration about the principal z-axis 

Wely  Elastic section modulus about the principal y-axis 

Welz Elastic section modulus about the principal z-axis 

Wply Plastic section modulus about the principal y-axis 

Wplz Plastic section modulus about the principal z-axis 

Mply+ Plastic moment about the principal y-axis for a positive My moment 

Mply- Plastic moment about the principal y-axis for a negative My moment 

Mplz+ Plastic moment about the principal z-axis for a positive Mz moment 

Mplz- Plastic moment about the principal z-axis for a negative Mz moment 

dy Shear center coordinate in principal y-axis measured from the centroid 

dz Shear center coordinate in principal z-axis measured from the centroid 

It Torsional  constant 

Iw Warping constant 

βy Mono-symmetry constant about the principal y-axis 

βz Mono-symmetry constant about the principal z-axis 
 

For background information regarding these parameters reference is made to [1]. 
 

 The centroid coordinates are not defined in the Profile Library since they refer to an arbitrary axis. 
These properties are always calculated by Scia Engineer and referenced to the Input Axis System 
(see [1]). 
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Annex C: Profile Library filters 

 
The Profile Library filters in the New Cross-section dialog allow an easy selection of specific types. Any 
set of section types can be gathered in a filter. This can be used to create filters for often used section 
types, filters for country specific sections etc. 
 
Within this Annex the creation of a filter is illustrated. 
 
The content of a filter is defined by means of a filter file. This file concerns a simple text file which is 
located in the folder of a library and has extension .FIL. 
 
The standard ProfileLibrary has several filter files provided by default, for example European.FIL, 
German.FIL, American.FIL, ... 
 
The name of the file defines the name of the filter i.e. how it will be visible within Scia Engineer. A filter 
file can be edited using a default text editor. The following picture shows the partial content of the 
European.FIL file: 
 

 
 
As can be seen from the screenshot, the content is a list of all the section Types which should be 
visible when this filter is selected.  
 
Filter files can be located in any Library folder, and can contain Types of different libraries.  
This is illustrated by means of the example of Chapter 2: at the end of that Chapter the UserLibrary 
contained a new UI section Type. 
 
- Using Windows Explorer, navigate to the UserLibrary folder (see Chapter 1). 
 
- Within this folder, create a new text file using any default text editor. 
 
- Save the file as MyFilter.FIL Make sure the .FIL extension is properly set (instead of .txt) 
 
- As content, input the desired section Types. For this example, the IPE Type and the UI Type are 
used: 
 

 
The IPE Type concerns a standard Type which is located in the ProfileLibrary while the UI Type is a 
user-defined Type located in the UserLibrary. As indicated above, the filter file itself can be located in 
any Library folder, and can contain Types of different libraries. 
 
- Save and close the MyFilter.FIL file. 
 
The filter file is now created and can be used within Scia Engineer. 
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- Launch Scia Engineer. 
 
- When the Open project dialog appears, either re-open an existing project or Cancel the dialog and 
create a new project as outlined in Chapter 2.  
 
 
- Go to Libraries > Cross-sections 
 

 
 
The Cross-section Manager as well as the New cross-section dialog will open. In case an existing 

project was opened which already contained cross-sections then press the  button to open the 
New cross-section dialog. 
 
- In the Available groups select Profile Library. 
 

- In the Available items of this group select the  icon. 
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At the bottom of the dialog the Profile Library filter combo-box contains the filters of all Libraries. 
 
- Click on the Profile Library filter combo-box and select MyFilter from the list. 
 

 
 
The Available items of this group now shows only the IPE and UI Types. 
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This example illustrated how filters for the Profile Library can be defined and used. 
 

- Close the New cross-section dialog by pressing . 
 

- Close the Cross-section manager by pressing . 
 
 
- Scia Engineer can now be closed, the project changes can be discarded. 
 
 
 
 

Extension: Translations 

Within the standard ProfileLibrary folder, additional files related to the filters can be found i.e. 
Filter_Names_05.txt, Filter_Names_07.txt, Filter_Names_0c.txt... 
 
Each of these files contains a translation of the filter file names for specific languages. The naming 
follows the same logic as outlined in Chapter 2 for the Descrip_ID and Source_ID files. 
 
 
 
The number used to identify a certain language concerns the Locale ID (LCID) as provided by 
Microsoft. More specifically the last two digits of the LCID are used. The following table illustrates this 
principle: 
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Language LCID Number used in filename 

Czech 

 

0405 05 

German 

 

0407 07 

English 

 

0809 09 

French 

 

040c 0c 

Dutch 

 

0813 13 

Slovak 041b 1b 
 
 
A list of all LCID's as provided by Microsoft can be found on the MSDN website. 
 
Thus when the interface of Scia Engineer is for example set to German, the filter strings will be read 
from the file Filter_Names_07.txt. In case this file does not exist, the content of Filter_Names.txt is 
used. 
 

 These Translations are only used by the standard ProfileLibrary, not the UserLibraries. 
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Annex D: Folder Content 

This Annex gives an overview of the relevant files located within the standard ProfileLibrary folder. 
 

File Description 

dbgeo Actual library file containing parameters and properties 

  

American.fil Filter file containing American sections 

Brazilian.fil Filter file containing Brazilian sections 

British.fil Filter file containing British sections 

Chinese.fil Filter file containing Chinese sections 

European.fil Filter file containing European sections 

Finnish.fil Filter file containing Finnish sections 

German.fil Filter file containing German sections 

Indian.fil Filter file containing Indian sections 

Japanese.fil Filter file containing Japanese sections 

Russian.fil Filter file containing Russian sections 

Swiss.fil Filter file containing Swiss sections 

  

Descrip_ID.txt File containing Description strings used in any language interface 

Descrip_ID_05.txt File containing Description strings used in the Czech language interface 

Descrip_ID_07.txt File containing Description strings used in the German language interface 

Descrip_ID_09.txt File containing Description strings used in the English language interface 

Descrip_ID_0c.txt File containing Description strings used in the French language interface 

Descrip_ID_13.txt File containing Description strings used in the Dutch language interface 

Descrip_ID_1b.txt File containing Description strings used in the Slovak language interface 

  

Filter_Names.txt File containing Filter name strings used in any language interface 

Filter_Names _05.txt File containing Filter name strings used in the Czech language interface 

Filter_Names _07.txt File containing Filter name strings used in the German language interface 

Filter_Names _09.txt File containing Filter name strings used in the English language interface 

Filter_Names _0c.txt File containing Filter name strings used in the French language interface 

Filter_Names _13.txt File containing Filter name strings used in the Dutch language interface 

Filter_Names _1b.txt File containing Filter name strings used in the Slovak language interface 

  

Source_ID.txt File containing Source strings used in any language interface 

Source _ID_05.txt File containing Source strings used in the Czech language interface 

Source _ID_07.txt File containing Source strings used in the German language interface 

Source _ID_09.txt File containing Source strings used in the English language interface 

Source _ID_0c.txt File containing Source strings used in the French language interface 

Source _ID_13.txt File containing Source strings used in the Dutch language interface 

Source _ID_1b.txt File containing Source strings used in the Slovak language interface 
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